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Desktop Publishing Guidelines 

Basic Guidelines 
• Use the same style consistently throughout the 

newsletter. 
• Use no more than 3 fonts in a document. 
• Use no more than 3 columns in portrait 

orientation and no more than 5 columns in 
landscape orientation. 

Graphic Considerations 
• Use borders to create special effects. 
• Use graphic elements to enhance the document. 

Text Considerations 
• Use sans serif fonts such as Arial and a font size 

of 12 to 18 for headings and titles. 
• Use serif fonts such as Times New Roman and a 

font size of 9 to 12 for text. 
• Limit the use of italics, bold, and underline. 

Opening Documents 
• Documents can be opened as

a copy so the original is not 
accidentally replaced. 

 

o On the Menu Bar, click 
on File  Open. 

o Click on the down 
arrow after Open and 
choose Open as Copy. 

• Opening documents as read only files protects 
the original document and forces it to be saved 
under a different name. 
o On the Menu Bar, click on File  Open. 
o Click on the down arrow after Open and 

choose Open Read-Only. 

Repairing a Document 
• Documents may become corrupted, but can 

frequently be opened anyway. 
o On the Menu Bar, click on File  Open. 
o Click on the down arrow after Open and 

choose Open and Repair. 
• The program repairs and opens the document. 

Resources for this class can be found at http://www.davis.k12.ut.us/district/etc/documents/word_news_doc.html  



 

 

Selecting Text 

Selecting Text with the Keyboard 
• Place the cursor at the beginning of the text to be 

selected. 
• Hold down the Shift key and use the arrow keys 

to move the cursor to the end of the text to be 
selected. 

Selecting Text in the Left Margin 
• Place the cursor in the left margin directly across 

from the text to be selected. 
• Click and drag down the margin.  
• The text is selected one line at a time. 

Selecting a Range of Text 
• Click at the beginning of the text to be selected. 
• Hold down the Shift key and click at the end of 

the text to be selected. 

Copying Text 

Copying to the Clipboard 
• When text or a graphic is copied, it is listed in 

the Clipboard of the Task Pane. 
• Up to 24 items may be on the Clipboard in this 

version of Microsoft Office. 

Seeing the Clipboard 
• If the Task Pane is not visible, on the Menu 

Bar, click on View  Task Pane. 
• Click on the down arrow at the top of the Task 

Pane and choose Clipboard. 

Pasting Text 

Pasting from the Task Pane 
• Bring up the Clipboard panel of the Task Pane 

as noted above. 
• Click in the document where the text is to be 

pasted. 
• Click on the desired text in the Clipboard. 

Dragging Text 
• Select the text to be moved. 
• Place the cursor in the middle of the selected 

area and drag the text to the new location. 
• Release the mouse button. 
• Be sure to watch the shaded marker to see 

where the text will be placed. 

Smart Tags 
• Smart Tags help control 

formatting of pasted text. 
• After pasting, click on the 

Smart Tag icon. 
• Choose the desired 

formatting. 

Inserting a File 
• Click in the document where the file is to be 

inserted. 
• On the Menu Bar, click on Insert þ File.... 
• Navigate to the location of the file. 
• Choose the file and click on the Insert button. 

Grid Lines 
• Grid Lines are non-printing lines displayed to 

guide the alignment of text and objects. 
• If the Drawing toolbar is not showing, on the 

Menu Bar, click on View  Toolbars  
Drawing. 

• On the Drawing toolbar, click on Draw  
Grid…. 

• In the Snap to section, 
remove the checkmarks 
so objects don’t move 
as the grid changes. 

• In the Grid settings 
section, set the 
horizontal and vertical 
spacing. 

• Click to select Display 
gridlines on screen. 

• Choose the number of 
spaces (based on the Grid Settings) for the 
vertical and the horizontal gridlines. 

• Click on OK. 

Sections and Breaks 
• A section can have its own formatting separate 

from other parts of the document. 

Types of Breaks 
• Next page – Inserts a break by starting a new 

page. 
• Continuous – Inserts a break and begins a new 

section while staying on the same page. 
• Even page – Inserts a break and starts the next 

section on an even-numbered page. 
• Odd page - Inserts a break and starts the next 

section on an odd-numbered page. 
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Creating a Section Break 
• On the Menu Bar, click on 

Insert  Break…. 

 

• Choose the desired type of 
break. 

• Click on OK. 

Removing a Section Break 
• Click on the Show/Hide (¶) 

button on the toolbar. 
• The section breaks and the page breaks are now 

displayed as dotted lines running across the page. 
• Click on the section break to be removed. 
• Press the Delete key on the keyboard. 
• Note - When a section break is deleted, the text 

above that point loses its formatting and takes on 
the formatting of the section below. 

Columns 
• Columns can make text more readable. 

Quick Columns 
• Highlight the text to be formatted as columns. 
• On the Standard toolbar, click 

on the Columns button ( ) 
and drag to highlight the 
desired number of columns. 

Existing Text to Columns 
• Highlight the text to be formatted as columns. 
• On the Menu Bar, click on Format  

Columns…. 

•  
• Click on the desired Preset number of columns: 

Two, Three, Left, or Right,  
o OR Type in the number in the Number of 

columns box. 
• Click to place a checkmark in the Line between 

box if a line is desired. 

• If the columns are to be of equal width, make 
sure there is a checkmark in the Equal column 
width box. 

• In Apply to:, select Whole document (to apply 
columns to the entire document), This point 
forward (to apply columns to the rest of the 
document), or This section (to apply columns to 
just this section). 

• Click on OK. 

Editing Columns 
 Click in the columns where the formatting is to 

be changed. 
 On the Menu Bar, click on Format  

Columns…. 

  
 Changing the Number of Columns 

o Click on the desired Preset number of 
columns: Two or Three,  

o OR Type in the number in the Number of 
columns box. 

 Custom Designed Columns 
o Click on the desired Preset for Left or 

Right, OR 
o Click to remove the checkmark from Equal 

column width. 
o In the Width and spacing section, adjust 

the width and spacing of each column. 
o Keep an eye on the Preview. 

 Line between the Columns 
o Click to place a checkmark in the Line 

between box. 
 Apply to 

o Click on the Apply to down arrow and 
choose This section or This point forward. 

 Click on OK. 
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Adjusting Column Widths with the Ruler 
 Click in the columns to be changed. 
 To move the space 

between the 
columns, on the Ruler, click on the white square 
in the middle of the column and drag to the 
desired location. 

 

 To adjust the size of the column, on the Ruler, 
click on the white bar at either end and drag to 
the desired size. This changes the size of the 
space between the columns. 

Inserting a Column Break 
 Click in the column where 

the break is desired. 
 On the Menu Bar, click on 

Insert  Break…. 
 Choose Column Break. 
 Click on OK. 

Balancing Columns 
 Columns run down the page and then start over 

again at the top. Balancing columns means 
placing a break so that the columns are the same 
length down the page. 

 Click at the end of the columns to be balanced. 
 On the Menu Bar, click on Insert  Break…. 
 Choose Continuous. 
 Click on OK. 
 The text is distributed evenly between the 

columns. 

Heading Across Columns 
 A heading may need to span the page across the 

columns. 
 Click at the beginning of the column farthest to 

the left. 
 Enter the heading and then press Enter. 
 Highlight the heading. 
 On the toolbar, click on the Columns button and 

drag to select one column. 
 Format the heading as desired. 

Text Boundaries Visible 
 On the Menu Bar, click on Tools  Options…. 
 Click on the View tab. 

  
 In the Print and Web Layout Options section, 

click to place a checkmark in front of Text 
boundaries. 

 Click on OK. 

Finding a Column Break 
• Click on the Show/Hide ¶ button on the toolbar. 
• The column breaks will now be displayed. 
• Note – Click on the Show/Hide ¶ button to turn 

off the display. 

Undoing Columns 
• Note – Word considers all text to be in columns. 

Normal text is in a single column. 
• Highlight the text to be changed to a single 

column. 
• Note – To change from this 

point to the end of the 
document, click at the desired 
beginning point. 

• On the Standard toolbar, click 
on the Columns button ( ) and drag to 
highlight one column. 
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Tab Stops 

Default Tab Stops 
• Tab stops are set for every .5 inches to begin 

with. 

Changing the 
Default Tab Stops 
• On the Menu Bar, 

click on Format 
Tabs…. 

• Click on the up or 
down arrows in the 
Default tab stops 
window to make 
the desired 
adjustments. 

• Click on OK. 
 

Types of Tab Stops 
Name Symbol Description 

Left Tab  Text is left justified against 
the position of the tab. 

Center 
Tab 

 Text is centered from the 
position of the tab. 

Right Tab  Text is right justified against 
the position of the tab. 

Decimal 
Tab  Text is justified with the 

decimal point (period) in line 
with the position of the tab. 

Bar Tab  Text is left justified against 
the position of the tab and a 
bar is placed in the text at the 
position of the tab. 

What is a Leader? 
• A leader is a series of marks like periods to help 

the eye follow the text easily. 
• A dot leader is a series of dots. (……….) 
• A hyphen leader is a series of hyphens (dashes). 

(---------) 
• An underscore leader is a series of underscores.  

(_______) 

Setting a Tab Stop with the Ruler 
• Highlight the desired text. 
• The Ruler should be visible.  If it is not, on the 

Menu Bar, click on View  Ruler. 
• Click on the tab selector at the far left end of the 

horizontal ruler until the desired type of tab is 
showing. (Note table above.) 

• Click on the ruler where the tab is to be placed. 

Customizing the Tab Stop 
• Highlight the desired text. 
• Double click on the tab stop to be customized.  
• Choose the alignment for the tab stop. 
• Choose the leader for the tab stop. 
• Click on OK. 
• Note – To change the position of the tab, enter it 

as a new tab and then clear the tab which is in 
the wrong position. 

Clearing (Deleting) a Tab Stop 
• Highlight the desired text. 
• On the Ruler, click on the tab stop and drag it 

off the ruler. 

Tabs as You Type 
• Set the desired tab(s) using the Ruler or with 

Format   Tabs…. 
• Type the desired text that needs the tab(s). 
• Remove the tab(s) and type the rest of the text. 

Drawing Canvas 

Turning Off the Drawing Canvas 
• The Drawing Canvas appears when drawing an 

AutoShape unless it has been turned off in 
Options. 

• On the Menu Bar, click on Tools  Options. 

•  
• Click on the General tab. 
• Remove the checkmark from Automatically 

create drawing canvas when inserting 
AutoShapes. 

• Click on OK. 
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The Drawing Toolbar 

 

 

Drawing an Object 

Drawing from the Toolbar 
• On the Drawing toolbar, click on the button for 

the desired shape. 
• In the document, click and drag to create the 

desired shape. 

Inserting AutoShapes 
• On the Drawing toolbar, click on AutoShapes. 
• Select the desired category and shape. 

o Lines - Choose from l
arrows, curves, and 
squiggles. 

ines, 

o Connectors - Choose 
lines or arrows to connect 
other shapes. 

o Basic Shapes - Choose 
boxes, shapes, or brackets. 

o Block Arrows - Choose 
from a variety of arrows, bent or straight. 

o Flowchart - Choose from a variety of 
flowchart symbols. 

o Stars and Banners - Choose multi-pointed 
starts or shaped banners. 

o Callouts - Choose speech or thought 
balloons or boxes. 

o More AutoShapes - Choose from clip art 
shapes. 

• In the document, click and drag to create the 
shape in the desired location. 

• Make adjustments to the shape as desired. 

Adding Text to an Object 
• Click on the desired object. 
• Right click on the object and select Add Text or 

Edit Text. 
• Enter the desired text. 
• Format the text with buttons on the Formatting 

toolbar. 

Moving an Object 
• Click on the object. 
• Place the cursor over the middle of the object.  

(The cursor becomes a four-headed arrow.) 
• Click and drag the line to the desired location. 

Resizing an Object 
• Click on the object. 
• Click on the hash-mark edge. 
• Click on one of the handles (the marks at the 

corners and the middle of the sides) and drag to 
the desired size. 

Reshaping an Object 
• Objects that have a yellow diamond can be 

reshaped. i.e. A banner made wider to hold more 
text. 

• Click on the object. 
• Click on the yellow diamond and drag to the 

desired shape or position. 

Changing Object Attributes 

Changing the Color of an Object 
• Click on the object. 
• On the Drawing toolbar, click on the down 

arrow next to Fill Color.   
• Choose the desired color. 

Changing the Color of a Line or Border 
• Click on the line or object. 
• On the Drawing toolbar, click on the down 

arrow next to Line Color.   
• Choose the desired color. 

Changing the Style of a Line 
• Click on the line or object. 
• On the Drawing toolbar, click on the Line Style 

button.   
• Choose the desired line style. 

Changing a Solid Line to a Dashed Line 
• Click on the line or object. 
• On the Drawing toolbar, click on the Dash Style 

button.   
• Choose the desired style. 

Changing the Style of an Arrow 
• Click on the arrow. 
• On the Drawing toolbar, click on the Arrow 

Style button.   
• Choose a style. 
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Formatting an Object 
• Right click on the object and choose Format 

AutoShape....  

Colors and Lines Tab 
• Fill Section  

o Click on the 
down arrow 
and choose a 
color to fill in 
behind. 

o Set the 
transparency of 
the fill as 
desired.  

o By choosing Fill Effects in the list, a 
window opens with tabs for gradient fill, 
texture fill, pattern fill, and picture fill. 

• Line Section 
o Click on the down arrow and choose a color 

for the border line. 
o Set other attributes for the line as needed. 

Size Tab 
• Set the size by exact measurement or by 

percentage of the original. 

Layout Tab 
• Choose the desired layout (usually Square). 
• Choose the desired alignment, Left, Center, 

Right, or Other. 

Text Box Tab 
• In the Internal 

margin section, 
adjust the margins 
of the text box. 
Measurements are 
from the edge of t
object. 

• To have the 
AutoShape resize automatically to fit the text, 
click to select Resize AutoShape to fit text. 

• Click on OK.  

Shadow Style 
• On the Drawing toolbar, click on the 

Shadow Style button.   
• Choose a shadow or choose Shadow 

Settings.. to bring up the Shadow Settings 
toolbar. 

• Note – Not all objects can have a shadow. 

3-D Style 
• On the Drawing toolbar, click on the 3-D Style 

button.   
• Choose the 3-D style or choose 3-D Settings... 

to bring up the 3-D Settings toolbar. 
• Note – Not all objects can use 3-D Style. 

Text Boxes 

Creating a Text Box 
• On the Drawing toolbar, click on the Text Box 

button. 
• In the document, click and drag to create the text 

box. 
• Enter the text. 

Creating a Text Box from Existing Text 
• Highlight the text to be placed in the text box. 
• On the Menu Bar, click on Insert  Text Box. 

Formatting the Text in a Text Box 
• Click on the text box. 
• Click on the shaded border to select all text in 

the text box OR highlight the desired text. 
• Use the Formatting toolbar to change the font, 

font size, font color, etc. 
• Click away from the text box. 

Formatting the Box of a Text Box 
• Click on the text box. 
• Formatting can be done from the Drawing 

toolbar OR… 
• Right click on the shaded border of the text box 

and choose 
Format Text 
Box…. 

• Click on the 
Colors and 
Lines tab. 

• In the Fill 
section, click 
on the down 
arrow and 
choose the fill 
color. 

• Adjust the transparency as desired. 
o By choosing Fill Effects in the list, a 

window opens with tabs for gradient fill, 
texture fill, pattern fill, and picture fill. 

• In the Line section, choose the color, the line, 
the dashed, and the weight of the border around 
the text box. 

• Click on OK. 
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Text Boxes without Text 

 

irection button. 

Deleting a Text Box 
. 

rder of the box. 

Linking Text Boxes 
akes the 

 

•  the second text box the text will flow into 

• 
• Text Box toolbar, click on 

tton. 

e 

• A text box could be used as a bar of color or 
pattern in a document. 

• Create a text box in the desired location. 
• On the Drawing toolbar, click on the down 

arrow of the Fill Color button and select the 
desired color or go to Fill Effects to add a 
gradient, a pattern, etc. 

Moving a Text Box 
• Click on the shaded border of the text box and 

drag it to the desired location. 

Resizing a Text Box 
• Click on the text box. 
• Move the cursor over one of the handles (the 

open circles at the corners and the middle of each 
edge). 

• The cursor will change to a two-headed arrow. 
• Click and drag to the appropriate size. 

Rotating Text in a Text Box 
• Click on the text box. 
• On the Text Box toolbar, 

click on the Change Text D

• Click on the text box
• Click on the shaded bo
• Press the Delete key on the keyboard. 

• Linking text boxes m
text that does not fit in the first
box flow to the designated 
box. 
Create
if it does not already exist. 
Click on the first text box. 
In the 
the Create Text Box Link bu

• Click in the second text box. (The cursor is a 
pouring bucket.) 

• The text now flows from the first text box to th
second. 

Unlinking Text Boxes 
• Breaking the link between text boxes prevents 

text from flowing from the first text box to the 
second text box. 

• Click on the first text box. 
• In the Text Box toolbar, 

click on the Break Forward Link button. 
• The text no longer flows from the first text box 

to the second. 

Graphics 
• Graphics can be added by clicking on the Menu 

Bar and choosing Insert  Picture  Clipart 
to get clipart from within Word or From file to 
get other graphics.  

• On the Picture toolbar, click on the Text 
Wrapping button and choose Square to be able 
to move the graphic around on the page.  

WordArt 
• On the 

Drawing 
toolbar, click 
on the 
WordArt 
button. 

• Click on a 
WordArt 
style and 
then click OK. 

• Enter the text in the 
window. 

• Choose a font and a 
font size. 

• A font with a simple 
design seems to work 
best. 

• Click OK. 

Editing the Text 
• Double click on the WordArt. 
• OR 
• Click on the WordArt.  (Click directly on one of 

the letters.) 

•  
• Click on the Edit Text... button on the WordArt 

toolbar. 
• Make changes as needed and then click on OK. 

Page 8
Educational Technology Center 
Davis School District, Farmington, Utah, 84025  Revised 8/29/2006 



 

 
WordArt Toolbar 

Name Icon Description 
Insert 

WordArt  
Click to insert a new 
WordArt. 

Edit Text 
 

Click to edit the text of the 
WordArt. 

WordArt 
Gallery  

Click to choose or change 
the style of the WordArt. 

Format 
WordArt  

Click to choose or change 
the colors and other 
formatting of the 
WordArt. 

WordArt 
Shape  

Click to choose the shape 
of the words in WordArt. 

Text 
Wrapping  

Click to choose or change 
the wrapping of document 
text around the WordArt. 
Note- Change the wrap to 
Square to be able to move 
it around on the page. 

WordArt 
Same 
Letter 

Heights 
 

Click to make all of the 
letters the same height (A 
lowercase a is the same 
height as the uppercase A. 

WordArt 
Vertical 

Text 
 

Click to toggle between a 
vertical or horizontal 
orientation of the text. 

WordArt 
Alignment  

Click to choose text 
alignment: Left, Center, 
Right, Justify. 

WordArt 
Character 
Spacing 

 
Click to choose or change 
the spacing between the 
letters in the WordArt. 

 

Deleting the Text 
• Click on the WordArt. 
• Press the Delete key on the keyboard. 

Nudging Graphics 
• Click on the graphic to be nudged. 
• Press the desired arrow key to move the graphic 

slightly. 
• Note – To make finer movement, hold down the 

Control key and press the desired arrow key. 

Advanced Features under Draw 

Grouping Objects 
• Grouping keeps all the objects together. 
• Click on the first object. 
• Hold down the Shift key and click on the other 

objects to be grouped. 
• On the Drawing toolbar, click on Draw þ 

Group. 

Ungrouping Objects 
• Click on the group of objects. 
• On the Drawing toolbar, click on Draw þ 

Ungroup. 

Regrouping Objects 
• Objects that have been ungrouped can be quickly 

regrouped. 
• On the Drawing toolbar, click on Draw þ 

Regroup. 

Changing the Order of Objects 
• As one object is placed over another, order 

determines which one is on top, next, etc. 
• Click on the object. 
• On the Drawing toolbar, click on Draw þ 

Order 
• Choose Bring to Front, Send to Back, Bring 

Forward, or Send Backward. 

Changing the Arrangement of Objects 
• Click on the object(s) to be changed. 
• On the Drawing toolbar, click on Draw and then 

choose one of the options below. 
• Snap allows the user to automatically line 

objects up on a grid. 
• Nudge allows the user to gently move an object. 
• Align or Distribute allows the user to determine 

vertical or horizontal alignment or distribution of 
objects. 

• Note - Multiple objects must be selected for this 
option. 

Rotating and Flipping Objects 
• Click on the object to be rotated or flipped. 
• On the Drawing toolbar, click on Draw þ 

Rotate or Flip. 
• Choose the desired rotation or flip. 
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Drawing Toolbar Chart 

 
Symbol Name Description 

 Draw A master menu for grouping, arranging, and organizing the object(s). 

 Select object Used to select an object. 

 AutoShapes A collection of lines, connectors, basic shapes, flowchart objects, stars, 
banners, and callouts. 

 Line Draw straight lines. 

 Arrow Draw a line with an arrowhead on the end. 

 Rectangle Draw a rectangle.  (Hold down the Shift key to create a square.) 

 Oval Draw circles and ovals.  (Hold down the Shift key to create a circle.) 

 Text Box Create text boxes.  (When used with an object, it creates text inside the 
shape.) 

 Insert Word Art Inserts Word Art into the spreadsheet. 

 
Insert Diagram or 

Organization Chart 
Inserts a Diagram or Organization Chart.  There is a variety of charts. 

 Insert Clip Art Inserts Clip Art into the spreadsheet. 

 Insert Picture from 
File 

Inserts a picture from a file. 

 Fill Color Specify the fill color of an object. 

 Line Color Specify the color of a line. 

 Font Color Specify the color of a font. 

 Line Style Change the style of a line. 

 Dash Style Change the style of a dashed line. 

 Arrow Style Change the style of arrows on the ends of the line. 

 Shadow Add or remove a shadow to the object.  (The Shadow Settings at the 
bottom will bring up a Toolbar with additional options.) 

 3-D Add, control, or remove 3-D settings.  (The 3-D Settings at the bottom 
will bring up a Toolbar with additional options.)  
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Headers and Footers 
 

Header and Footer Toolbar 

 
Name Button Description 

Insert AutoText 

 

Click on AutoText and select the text to be inserted. AutoText 
provides standard information for quick insertion such as 
Attention Line, Closing, Header/Footer, Mailing Instructions, 
Reference Line, Salutation, and Subject Line. 

Insert Page Number  Click on Insert Page Number to insert the page number. 
Insert Number of Pages 

 
Click on Insert Number of Pages to insert the number of 
pages in the document. 

Format Page Number 
 

Click on Format Page Number to change the type of page 
numbering. 

Insert Date  Click on Insert Date to insert the current date. 
Insert Time  Click on Insert Time to insert the current time. 
Page Setup  Click on Page Setup to change the setup of the page. 
Show/Hide Document 
Text  

Click on Show/Hide Document Text to show or hide the text 
of the document. 

Same as Previous 
 

Click on Same as Previous to make the current header or 
footer the same as the header or footer in the previous section. 

Switch Between Header 
and Footer  

Click on Switch Between Header and Footer to switch 
between the header and the footer. 

Show Previous 
 

Click on Show Previous to move to the header or footer of the 
previous section. 

Show Next 
 

Click on Show Next to move to the header or footer of the next 
section. 

Close Header and Footer 
 

Click on Close to the Header and Footer toolbar and return to 
the document. 

Creating Headers and Footers 
• Click on the page where the headers and/or 

footers are to begin. 
• On the Menu Bar, click on View  Header 

and Footer. 
• Enter the desired information. 
• Click on the Close button. 

No Header on First Page 
• Click on the first page. 
• On the Menu Bar, click on View  Header 

and Footer. 
• On the Menu Bar, click on File  Page Setup. 
• Click on the Layout tab. 
• In the Headers and Footers section, click to 

choose Different first page. 
• Click on OK. 
• Click on the Close button. 

Editing Headers and Footers 
• Double click on the header or footer to be 

changed. 
• Make the desired changes. 
• Click on the Close button. 

Different Headers/Footers on the First Page 
• On the Menu Bar, click on File  Page Setup. 
• Click on the Layout tab. 
• The headers and footers can be different on the 

first page than the rest of the document. 
• In the Headers and Footers section, click to 

choose Different first page. 
• Click on OK. 
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Different Headers/Footers for Odd and Even 
Pages 
• On the Menu Bar, click on File  Page Setup. 
• Click on the Layout tab. 
• The headers and footers can be different on the 

odd numbered pages than the even numbered 
pages. 

• In the Headers and Footers section, click to 
choose Different odd and even. 

• Click on OK. 

Adjusting Text Alignment in Headers and 
Footers 
• The header and the footer are set up with a center 

tab and a right tab. 
• To place text on the left and on the right of the 

same line, enter the text at the left, press the Tab 
key twice, and then enter the text on the right. 

• To place text on the left, the center, and the right 
of the same line, enter the text at the left, press 
the Tab key, enter the text for the center, press 
the Tab key, and then enter the text on the right. 

Additional Information 
• Headers and footers are used to indicate the page 

number or the title of the paper. 
• The footer can be used to indicate the date of last 

revision or the name of the file. 
• Space used in the header and footer is subtracted 

from the available space for the body of the 
document. 

Formatting a Paragraph 
• Click in the paragraph to be formatted. 
• On the Menu Bar, click on Format þ 

Paragraph.... 

•  

• Click on the Indents and Spacing tab. 
• Click on the down arrow for Alignment:, and 

adjust as needed. 
• In the Indentation section, choose the Left or 

Right Indentation as desired. 
• Special contains First Line Indentation and 

Hanging Indentation. 
• In the Spacing section, adjust the spacing before 

and after the paragraph as desired. 
• Note - When the spacing is different in a 

document, check the spacing before and after the 
paragraphs. 

• Line spacing adjusts the spacing of all the lines 
in the paragraph. 

• Click on the Line and 
Page Breaks tab. 

• Make sure there is a 
checkmark selecting 
Widow/Orphan 
Control to keep the text 
from having a single 
line alone on the top or 
bottom of a page. 

Drop Cap Letters 
• Drop Caps are used at the beginning of a 

paragraph as a decorative flourish. 
• Note – Drop Cap is not available if there are 

spaces in front of the letters. 
• Click at the beginning of the paragraph that is to 

have the Drop Caps. 
• On the Menu Bar, click on Format  Drop 

Cap. 
• In the Position section, 

click on Dropped. 
• In the Options section: 

o Choose the font. 
o Choose the number 

of lines to drop. 
o Choose the distance 

from the text 
(usually 0). 

• Click on OK. 
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Adjusting a Drop Cap 
• Click on the Drop Cap. 
• Click on the hash-mark border. 
• To resize the Drop Cap, click on one 

of the black dots and drag to the desired size. 
• To change the position of the Drop Cap, click 

on the border and drag it to the desired location. 
• To change the font, highlight the letter and use 

the toolbar as usual. (The drop down list shows 
what the font looks like.) 

Removing a Drop 
Cap 
• Click in the 

paragraph. 
• On the Menu Bar, 

click on Format 
Drop Cap. 

• In the Position 
section, click on 
None. 

Saving the 
Newsletter 

Making the Newsletter as Read-Only 
• This keeps the file from being overwritten.  
• Save the newsletter to the desired location. 
• Navigate to the location of the newsletter. 
• Right click on the newsletter file and choose 

Properties. 

•  
• In the Attributes section, click to select Read-

only. 
• Click on OK. 

Saving the Newsletter as a Template 
• This makes it available on the computer for 

future use as the beginning of each new 
newsletter. 

Creating a Template from a Document 
• Open the document to be used as the template. 
• Make the desired changes to the document. 
• On the Menu Bar, click on File þ Save As. 
• Enter the name of the template. 
• Click on the down arrow in the Save as Type 

box and choose Document Template. 
• Notice that the template will be saved in the 

Templates folder, making it available in the list 
of templates on the computer you are working 
on. 

• Click on the Save button. 

Creating a Template 
• On the Menu Bar, click on File þ New. 
• The Task Pane opens in New Document. 
• In the New section, click on From existing 

document…. 
• Navigate to and open the document that best 

serves as a starting point. 
• Create the template as it should appear. 
• Information that will remain the same in all of 

the documents should be entered. 
• Information that will change should have a note 

about the type of information you want in that 
location.  

• In the Create New box, click on Template. 
• Click on OK. 
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Editing a Template Saved in the Template 
Folder 
• On the Menu Bar, click on File þ New. 
• The Task Pane opens in New Document. 
• In the Templates section, click on On my 

computer… 

•  
• Click on the General tab. 
• Select the template and click on Open. 
• Make the desired changes to the template and 

save it as noted above. 

Editing a Template not Saved in the Template 
Folder 
• On the Menu Bar, click on File þ Open. 
• Change the Files of Type by clicking on the 

down arrow and choosing Document 
Templates. 

• Navigate to the desired template, click to select 
it, and click on Open. 

• Make the desired changes to the template. 
• Save it as noted above. 

•  

Deleting a Template 
• On the Menu Bar, click on File þ New. 
• Right click on the template and choose Delete. 
• In response to whether the template should be 

deleted, click on Yes. 

Templates from Office Online 
• On the Menu Bar, click on File þ New….  
• The Task Pane opens in New Document. 
• In the Templates section, click on Templates on 

Office Online. 
• Choose the United States to indicate the location. 
• In the first Search box at the top, make sure that 

Templates is chosen. 
• In the second Search box at the top, enter 

Newsletter and click on the Go button. 
• Scroll through the list and choose a template. 
• Click on the Download Now button. 
• Click on the Accept button. 
• Click on Yes if a Security Warning window 

comes up. ActiveX will need to be installed if it 
is not currently installed on the computer. 

• Work with the template. 
• Save the template. 

Saving the Template 
• On the Menu Bar, click on File þ Save As. 
• In the Save As window, notice that the template 

will be saved in a location called Template. 
• Click on the down arrow in the Save in box and 

notice where the template is being stored. 
• Note: This could be essential information for 

deleting the template later. 
• Enter a name for the template and click on OK. 
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